
 
 
 
 

The goal of this tutorial is to introduce you to the Millennium record editor.  Record creation, editing, and 
deletion processes are common to all Millennium modules. In this tutorial we will address bibliographic, 
item, and order records. 
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[New Chapter: Logging in] 
 
[Login to Millennium Cataloging on XTRAIN using login miltutor/miltutor, and password of tutor/tutor] 
 
This tutorial begins with the Millennium Cataloging client, but record creation and editing are also 
available in the Acquisitions or Serials clients. Note that for record creation and editing, it is always 
necessary to use an appropriate set of initials and passwords, since all editor functions require record 
level authorization. 
 
A bibliographic record must be created first. Item and order records can then be attached to it.  Most 
bibliographic records are not keyed into the database by hand, but are loaded in a batch process that 
is dependent on the source of the record. However, creating a record manually allows us to see the 
parts of the record. 
 
To create the bibliographic record, click the NEW button on the Tool bar. Note that most commands in 
Millennium are also accessible via a menu command, a keyboard command, or a screen button. 
 
[Click ‘New’ button on the Tool bar] 
 
[Select tutorbib template] 
 
Depending on your login configuration, you may be prompted to select a template.  If you are 
prompted, select the one that most closely meets your needs. Because the system is highly 
customizable, both by library and by login, your screen may differ from this example, but you should 
customize the settings that are most efficient for your work flow. 
 
Choose the appropriate template and click ‘select’ 
 
The first prompt encountered is for a date field.  In Millennium, date fields have special shortcuts, for 
example, Typing the letter “t” will automatically insert today’s date. 
 
[Type ‘t’ in Cat Date for today’s date] 
 
Click ‘next’ to move through the prompts of the record creation assistant. 
 
Depending on the template selected, there may be prompts to enter other fixed length field data, 
which have predefined values. The range of values can be seen by double clicking on the field, or by 
depressing the space bar, or the value can also be keyed in directly. 



 
[Enter iu in the LOC fix field] 
 
 
Once the fixed length field prompts have all been presented, the template will move on to variable 
length field prompts.  Variable length fields can either be MARC or non MARC, as will be seen.  In this 
bibliographic record, all of the variable length fields are MARC fields. Now, we will enter all of the 
variable length field data. 
 
[Enter 1591842239 into the ISBN field] 
[Enter the author name Kawasaki, Guy into the author prompt] 

[Enter the title ‘Reality check : |b the irreverent guide to outsmarting, outmanaging, and 
outmarketing your competition’ into the title prompt] 

The subtitle is designated in MARC as a separate subfield. The primary subfield, subfield a, is inserted 
automatically, but subsequent subfields should be input using the vertical bar as the subfield delimiter. 

[Enter the publication information New York : |bPortfolio, |c2008.] 
 
When subfields are standard for a field, for example, for publication information, the subfield delimiters 
can be put into the template for easier data entry.  
 
[Enter 474 p. in Description] 
[Enter ‘Entrepreneurship’ in Subject] 
 
When there are no more prompts, save the record, or go back to any part of the record to make 
changes or additions.  Once the record is saved, Millennium automatically assigns a unique record 
number.   
 
[New Chapter: Record creation, Item record] 
 
As mentioned earlier, item record creation typically occurs independent of bibliographic record 
creation, although it is possible to configure the system to automatically begin creating attached 
records (such as items or orders) after saving a new bibliographic record. For this tutorial, we will 
follow the most common workflow of attaching a new item to an existing bibliographic record. 
 
[Click Continue button when ready] 
 
In order to attach a new item record to this bibliographic record, first access the existing bibliographic 
record. Then, click on the Summary button on the Tool bar to get access to all other attached record 
types. 
 
[Click on the Summary button on the Navigation bar] 
 
At the Summary screen, change the view from all attached records to item records, by selecting ‘item’ 
from the View drop down menu. 
 
[Select item. Click dropdown to see all items] 
 
A login can be configured to use a single template for each record type, or to prompt the user for a 
template. To set these preferences, start by accessing the Admin menu then choose ‘settings’.  Item 
creation for this login is set to always use the iumono template. Click the dropdown to see all options.   
 
The system can be set to always use the iumono template, or any specified template, to prompt for a 
template the first time and continue using that template, or to always prompt for a template upon 
record creation.  
 



In this case, we set the system to always prompt for a template, then set order creation to also always 
prompt for a template, then save the settings.  To attach a new item record, click the ‘Attach New 
Item’ button.  It is possible to adjust the settings so that an item or order record is created 
immediately following the creation of a bibliographic record. In that case the preceding steps are 
unnecessary. 
 
[Change the view drop down from All to Item] 
 
The system then prompts for single or multiple item creation. The system can be configured to use a 
single item as a default.  In this example, we will choose single item. 
 
[Click Attach New Item, then select Single Item] 
 
As we configured in the Settings menu, the system now prompts us for a new item template. 
 
[Select iumono template] 
[Enter item type of 16 Spoken CD] 
 
Now move through the record creation process, modifying values as necessary. For fixed length fields, 
you can always see a list of values by double-clicking in the field.  Then choose the appropriate value 
and click ‘ok’.  
 
As before click ‘next’ to continue to the following prompt. 
 
The prompts that appear, and the order in which they appear, are a function of the template, and can 
be adjusted in order to offer the most logical or most frequently used values. 
 
[Enter a price of $29.95] 
[Enter a location of iu3] 
 
For item records, note that Location and Item Type will determine the way that this material will 
circulate. The price field will partly determine the amount that the patron is billed if the material is lost. 
 
[Enter barcode 33433085490765]    
[Click Save on the Navigation Bar] 
 
Once all prompted fields have been entered, other fields that are appropriate for this record, such as 
volume or call number, may be entered. 
 
[New Chapter: Record creation, Order record] 
 
[Select Millennium toolbar, and change to Acquisitions mode (not shown)] 
  
As with a bibliographic record, fixed length fields, such as Item Type, appear at the top of the record, 
while variable length fields, such as Bar Code, appear at the bottom.  When the record is complete, 
click the ‘save’ button on the tool bar.  When done, close the record to make it available for other 
transactions. 
 
Order records can be added to a bibliographic record similarly to an item record. They use templates, 
and have both fixed and variable length fields. If this is a first time order, the order record may be 
created along with the bibliographic record to be loaded, but if this is an additional or replacement 
copy, the order would be added to an existing bibliographic record. Here we will demonstrate the 
second workflow. 
 
[Click ‘Continue’ button when ready] 
 
This record is being added from the Acquisitions module, which will have slightly different attributes 
from the Cataloging module but the basic layout is the same. Let’s start by performing a search for an 
existing bibliographic record. 



 
[Search author Kawasaki, Guy] 
[Click on the Summary button on the Navigation bar] 
[Change the view drop down from All to Order] 
 
After choosing the correct bibliographic record, access the record summary screen, and change the 
view from All to Order. Then click the Attach New Order button. 
 
[Click on attach new order button] 
[Select tutororder template] 
 
As before, there may be a choice of templates, or this login may have a template preference already 
set up.  The fields that are prompted for, and the order in which they appear, are a property of the 
template. Some fixed fields will already have values in them, which are also a property of the 
template. 
 
<select location iu3> 
<select fund iures> 
<select copies 2> 
<click Next> 
<select New/Replace d> 
<select estimated price 29.95> 
<select format b> 
<click Next> 
<select vendor bwkr> 
<select Selector Weiss> 
 
Notice that the location, fund, and number of copies are always displayed in a grid.  This allows the 
library to order multiple copies of a title, and associate each copy with the correct library location and 
fund, in case these are different. 
 
Each library will have different choices of fields and values that best reflect the information that they 
wish to track and count.  
 
Most fixed fields will either have a null value default or the most common choice for that field, such as 
format ‘book’. If the current value is appropriate, simply hit Enter or click the Next button without 
making any changes. 
 
If you know the code value for a field, you may key that value directly at the prompt. 
 
As with other record types, the variable length fields, such as Selector, are added after the fixed length 
fields. 
 
When the order record is complete, click the Save button on the Toolbar  or use Control-S keyboard 
shortcut to save the record. 
 
[Show completed order record, and click Save] 
 
When an order record is saved, a pop up box will appear, showing whether funds will be encumbered.  
The box will also reflect the status of the qpo check box from the order record tab as to whether a 
Purchase Order should be sent to the vendor. This message can be acknowledged by clicking Yes. 
 
[Click YES] 
When done, close the record to make it available for other transactions. 
 
Editing existing bib records can be done from the cataloging module if the user has sufficient 
authorization. 
To begin, retrieve the desired bibliographic record. 
 



[Search author Kawasaki, Guy] 
[Click on the Insert button on the Navigation bar and drop down the list of possible fields] 
 
When a record is first displayed, there is an upper frame that has a brief display of the bibliographic 
information, then summary information about the attached records in the lower frame. To edit the 
bibliographic record, select the Edit button on the toolbar. Notice that there is also a View button, for 
staff who need to be able to see the full detail of the bibliographic record but may not have permission 
to edit that record type. 
 
[Click on Edit button on toolbar] 
 
Editing bibliographic records may be done for multiple reasons – usually either correcting information 
or inserting new information. To insert a variable length field, you can use a number of different 
methods. There is an insert button on the navigation bar, you can access the command with the menu 
bar, use the keyboard shortcut (CTRL-I) or choose the ‘Insert Field’ command from a right click option 
box.  
 
This dialog box will give you the option of selecting the field type that you want to insert.  The choices 
are gathered by the alphabetic field tags, with a suggested MARC tag for bibliographic records. The 
MARC tag can be overwritten, for example by changing the call number tag from 090 to 099. Once you 
have selected the desired field type, key in the data. 
 
[Select call number with “c” and tab past the MARC tag] 
[Enter HD62.5|b.K382 2008] 
 
Note the separate subfield |b in this call number. Once the data is entered, click ‘ok’ to insert the field. 
 
[Right click and select Insert field] 
 
Now let’s insert another field using the right-click menu option. 
 
[Select Subject from drop box] 
 
To change the field type to insert, click the drop down menu and make a selection, in this case, 
‘Subject’. 
 
Notice that although the MARC tag is pre-entered, the first and second indicators may not have been 
pre-entered, if they are subject to variation. The second indicator of the 650 field shows a pink 
background. This login uses that background color as an alert color, to show that there should be a 
value that needs to be entered. When this occurs, key in the appropriate value. Then key in the field 
data and click ‘ok’ to insert. 
 
[Insert 0 in second indicator box] 
[Then key in the field data and click ‘ok’ to insert] 
[Insert New business enterprises. In text box] 
 
Bibliographic records also have special fields that are stored in appositionally defined data elements. 
These are the 006, 007, 008 and leader fields. These should NEVER be edited directly on the line, but 
only in the expanded form. To access the expanded form, right-click on the field and select ‘Expand 
Field’. 
 
[Position cursor on Leader and right click, then Expand field] 
[Double click on Bib Level] 
 
Changes can now be made in the table form, with valid values selected as in fixed length fields. To see 
the list of acceptable values, double-click on the field. Select the desired value and click ok.   
 
[OK] 
 



When done editing the fields, right-click and select ‘collapse field’. 
 
[Right click to show the Collapse Field option] 
[Click Save and close record, using usual language] 
 
Once the editing is complete, be sure to save your changes. 
 
When done, close the record to make it available for other transactions. 
 
As with the bibliographic record, item records can also be modified in the cataloging module, if the 
user has sufficient authorization. 
 
[Click the Continue button when ready] 
 
To begin, retrieve the parent bibliographic record. 
 
[Search author Kawasaki, Guy] 
 
In the Cataloging module, the primary attached record type is the item. If there is a single attached 
item, this will be opened immediately. If there are multiple items, you will need to select from a 
Summary screen. 
 
Notice that many of the fixed fields in the item record cannot be edited. These are system maintained 
fields and have a different background color to set them apart. To change one of the values in the 
editable fields, such as Item Type, just double-click in the field. 

 
[Select item type and double click. Change value to 0 Books] 
 
Notice this list is sorted alphabetically by the field values label, (such as CD-Spoken), because we 
double clicked on the label in the item record. To sort by the numeric field code instead, first close this 
window by clicking ‘cancel’. 
 
[Click Cancel] 
 
 Now double-click on the field’s numeric code value. In the example of Item type, we double-click on 
‘16’.  Now the list is sorted by the numeric field code instead of the field label. To make a change to 
the field, select the desired value and click ‘ok’. 
 
[Select Books and click OK] 
 
Now let’s insert another variable length field.  Change the field value to ‘message’.  Some of the 
variable length fields have special properties.  For example, the message field will cause a pop-up 
window to appear at Check-Out or Check-In with the message information keyed in this field.  The new 
message now appears in the variable length field area at the bottom of the screen. 
 
Now let’s insert another variable length field. 
 
Now change the field type to Volume. 
 
Volume fields should only be used when the intention is to distinguish between items that different in 
content, but attached to the same bibliographic record. The effect will be that all holds placed on the 
material will be item level holds, rather than bibliographic level holds. 
 
To delete a variable length field, place the cursor in that field, right-click on the mouse and select 
‘delete field’. 
 
When you have completed editing the record, be sure to save your changes. 
 



In many cases, existing records in your catalog can serve as building blocks for new records, so an 
efficient alternative to creating a new record is to copy an existing record. 
 
[Click Continue button when ready] 
 
To copy a record, access the existing bibliographic record, open the Edit menu and select ‘Copy 
Record’. 
 
[From the Edit menu, select Copy Record] 
 
As with all new records in Millennium, the system uses templates to create this copy.  Select the 
appropriate template for this record. 
 
The fixed and variable length fields which are copied onto the second record can be customized for 
your library’s needs. For adding copies to a bibliographic record, it is often only necessary to insert a 
barcode in the new record, and it’s ready. 
 
To do so, insert a new variable-length field with the right-click menu command. 
 
[Right click and select  Insert field and then select barcode] 
 
Then scan in the new barcode and click ‘ok’ 
 
[Insert 33433085490781] 
 
Then click save to finish creating the new record.  
 
[Click Save in Navigation bar] 
 
In this case, we were able to rapidly create a new record by using the copy record function instead of 
creating a new record from scratch. 
 
It is possible to see how your catalog editing will appear in the WebPAC, by selecting the Public Display 
command from the View menu. 
 
[Select View menu, then choose Public Display] 
 
In this new web browser window, we see the Public Display of the newly created record. 
 
When done, close the record to make it available for other transactions. 
 
[Close record] 
 
It occasionally happens that a secondary record such as an item or order record becomes attached to 
the wrong bibliographic record. Rather than deleting the record and creating a new one, which might 
not be possible if the record has transactions, it is much easier to transfer the attached record to the 
correct record. 
 
Transferring items from one bib record to another is best done with a split screen displaying the source 
and destination.  To change your settings to split screen, first select the Admin menu 
 
[Select the Admin menu] 
 
Then select ‘Settings’. 
 
Then, choose the Windows tab 
 
[Select Windows Tab] 
 



Then change the option from Single Window Mode to Multi Window mode 
 
[Change radio button to Multi Window mode> 
 
And click OK 
 
[Select OK] 
 
Now, search for the bibliographic record that currently has the attached item 
 
[Title Search: German essays on art history] 
 
[Highlight line 2, then 3, then 2] 
 
Choose the first bibliographic record, which has the item to be transferred, and click ‘Select’. 
 
[Click on Select] 
 
Now we have 2 windows open. Return to the original Browse screen window to continue the process. 
 
[Click on Browse button] 
 
Then choose the second bibliographic record, which is the destination record for this item. 
 
[Select line 3 and Select] 
 
Then click ‘Select’. 
 
[Click on Select] 
 
Next, open the Window menu and choose the Tile Vertically option to view both bibliographic records 
side by side. 
 
[Select Window | Tile Vertically] 
 
On the first bibliographic record, select the item to be transferred 
 
[Highlight line 1] 
 
Then open the Edit menu and choose Transfer Attached 
 
[Select Edit | transfer Attach] 
 
Because the other bibliographic record is already open, Millennium offers that record as the destination 
in the Transfer Attached menu. Now select that record to initiate the transfer. 
 
[Select Bib b12129604] 
 
The system prompts us to confirm the transfer, retaining the source record. 
 
The item record is now transferred. To view the item, change the View drop down menu on the 
destination record to ‘Item’. 
 
[On bib b1219604, change View to Item] 
 
When done, remember to close all records so they are available for other transactions. 
 
[Close both records] 
 



Deletion of individual records is subject to a number of conditions. For example, a bibliographic record 
cannot be deleted without first deleting the attached items or orders on that record. Items cannot be 
deleted while they are checked out, or have holds on them. Order records cannot be deleted while 
they have funds encumbered or outstanding. 
 
To begin, first retrieve a bibliographic record. We can do this, as previously, by searching via the 
indexes. Now we can close this record to illustrate another record retrieval method.  We can quickly 
repeat previous searches by opening the file menu and using the previous search from the ‘Recent 
Search’ option. 
 
Now our previously viewed bibliographic record is displayed, and we can delete one of its item records. 
 
[Search author Weiss, Paul] 
[Show the summary screen for item records, and select the 2nd item> 
 
Select the second attached item record. Then de-select the first item record. Then click the delete 
button. 
 
[Click Delete] 
 
Notice that the system asks you to confirm that you want to delete the single item.  However, if you 
choose all attached items, the message will change. 
 
Now reselect the first attached item record.  Now click the ‘delete’ button again. 
 
[Show the summary screen for item records, and select BOTH items] 
[Click the Delete button and click on Delete Bib Record] 
 
The system now lists both attached items to be deleted and there is also an option to delete the 
bibliographic record, since all of its attached records are being deleted. 
 
When done, close the record to make it available for other transactions. 
 
The deletion process is the same for attached order records.  First, retrieve a bibliographic record with 
attached orders. 
 
[Search author Kawasaki, Guy] 
[Change view from Item to Order] 
 
Then change the record view from Item to Order.  Then click ‘delete’. 
 
[Click delete] 
 
The system will then ask you to confirm that you want to delete the selected attached orders. 
 
[Select the order record that was created, and click Delete, and then Yes] 
 
Millennium does not permit this deletion. 
 
Single order records can be deleted from the summary view ONLY if they have a status of cancelled, or 
ON HOLD. Any other status that would have an impact on the financial reporting of the system, will not 
permit the deletion. 
 
When done, close the record to make it available for other transactions. 
 
Another way to delete a bibliographic record, with or without attachments, is from the File menu within 
the editing screen. 
 
[Select Edit from tool bar] 



 
Now that the record is in Edit mode, open the file menu and choose ‘Delete Bibliographic record’. 
 
[Select File menu, then select Delete bibliographic record> 
 
If there are no records attached to the bibliographic record, the system will allow you to delete it.  
However, if there are records attached, a pop up box will appear asking whether or not to delete the 
bibliographic record and all attached records. 
 
When done, close the record to make it available for other transactions. 
 
These methods for deleting records are only for small numbers of records. Batch deleting is a different 
function and should be considered for larger jobs.  
 
[New Chapter: End of record editing tutorial] 
 
There are many other tools and functions available to you in the record editor. Please consult the 
Innovative Guide and Reference and the many resources on CSDirect for more information. 

 

[Click Continue button when ready] 

Please fill out our survey with any comments or suggestions regarding our video tutorial. 

Thank you. 


	[Enter the title ‘Reality check : |b the irreverent guide to outsmarting, outmanaging, and outmarketing your competition’ into the title prompt]
	The subtitle is designated in MARC as a separate subfield. The primary subfield, subfield a, is inserted automatically, but subsequent subfields should be input using the vertical bar as the subfield delimiter.

